DYNAMIC ANALYSIS OF

HYDRAULIC BACKHOE EXCAVATOR VEHICLE

UTILIZING

DYNAMIC FINITE ELEMENT ANALYSIS AND 3D SOLID MODELING

A Thesis

Presented to the faculty of the Department of Mechanical Engineering

California State University, Sacramento

Submitted in partial satisfaction of the requirements for the degree of

MASTER OF SCIENCE

in

Mechanical Engineering

by

Hamid Issa Hanfoosh Al Nuaimi

FALL 2013
DYNAMIC ANALYSIS OF

HYDRAULIC BACKHOE EXCAVATOR VEHICLE

UTILIZING

DYNAMIC FINITE ELEMENT ANALYSIS AND 3D SOLID MODELING

A Thesis

by

Hamid Issa Hanfoosh Al Nuaimi

Approved by:

__________________________________, Committee Chair
Jose Granda, Ph.D.

__________________________________, Second Reader
Akihiko Kumagai, Ph.D.

__________________________________
Date
Student: Hamid Issa Hanfoosh Al Nuaimi

I certify that this student has met the requirements for format contained in the University format manual, and that this thesis is suitable for shelving in the Library and credit is to be awarded for the thesis.

__________________________, Graduate Coordinator

Akihiko Kumagai, Ph.D. Date

Department of Mechanical Engineering
Abstract of DYNAMIC ANALYSIS OF HYDRAULIC BACKHOE EXCAVATOR VEHICLE UTILIZING DYNAMIC FINITE ELEMENT ANALYSIS AND 3D SOLID MODELING by Hamid Issa Hanfoosh Al Nuaimi

This thesis studies the concept of finite element method and its application to the Bucket attachment for excavator design. In fact, the purpose of this thesis was to find a new way for designing an excavator, which is more efficient from the economic and mechanical point of view. The present review provides brief information about the Bucket attachment for an excavator. The use of Hradox-400 material instead of Steel ASAI C 2010 in the Bucket Attachment for the Excavator can increase the volumetric capacity of the bucket and make it lighter. As the present mechanism used in Bucket attachment for excavator is subjected to torsional and bending stresses, so it is necessary to design a new mechanism. The finite element method was used to find out the optimized design solution. SOLIDWORKS 2013 Software was used for CAD design. Finite Element Methodology was used to find out dynamic fatigue failure of excavator arm mechanism design using SIMWISE 4D software for different material properties. Finite Element Methodology
increased the productivity of Bucket attachment for excavator mechanism design, helped to conceptualize the product, reduced time required to design and analysis. The results of this thesis are stress; strain and displacement of the final geometry of the Hardox- 400 for arm and boom are lower than max stress and strain. In addition, the attach how can make the weight of the stick and boom lighter than steel. Although the costs of mechanical components made of Hardox-400 are more expensive than those made of steel, the results of this study clearly reveal the benefit of the increased capacity of the excavator outweighs the initial cost problem in the end.

__________________________, Committee Chair
Jose Granda, Ph.D.
__________________________
Date
ACKNOWLEDGEMENTS

First, I would like to take this opportunity to first and foremost thank God for being my strength and guide in the writing of this thesis. Without Him, I would not have had the wisdom or the physical ability to do so.

While working on this Thesis, some people helped me to reach where I am today and I would like to thank all of them for their support and patience.

In addition, I would like to thank my Master Thesis advisor, Dr. Jose Granda for giving me an opportunity to plunge into this very exciting territory of Vibration Analysis.

I would also like to thank Prof. Akihiko Kumagai, my second reader who has spent his invaluable time in reviewing my thesis.

Also, I would like to thank my parents, my uncle Ahmed Abbas and my wife who support me to get my dream and I dedicated my work to them and all my brothers and sisters.

Finally, I thank my family and friends who have always supported me and are the biggest reason of my success.

Hamid Issa Hanfoosh AL-Nuaimi

12/06/2013
# TABLE OF CONTENTS

| Acknowledgements                                                                 | vii       |
| List of Tables                                                                     | xi        |
| List of Figures                                                                     | xii       |

Chapter

1. **INTRODUCTION** ................................................................................. 1
   1.1 Problem Statement .................................................................... 1
   1.2 Finite Element Method .......................................................... 3
   1.3 Software Used ......................................................................... 4

2. **BACKGROUND OF THE STUDY** .......................................................... 6
   2.1 What is an EXCAVATOR? .............................................................. 6
   2.2 What does An EXCAVATOR Consist of? ........................................... 7
   2.3 How does EXCAVATOR Work? ........................................................ 8
   2.4 What is Hardox- 400? .................................................................. 11
   2.5 Comparison between the Properties of Hardox 400 and Steel AISI C1020 ................................................................................. 11

3. **SOLID MODELING OF EXCAVATOR** .................................................... 13
   3.1 EXCAVATOR Specification ............................................................ 13
   3.2 Design Phase 1 ........................................................................... 15
      3.2.1 3D Modeling of EXCAVATOR Parts ........................................ 15
         3.2.1.1 Solid Modeling of BOOM ................................................ 16
         3.2.1.2 Solid Modeling of BUCKET ............................................. 32
         3.2.1.3 Solid Modeling of STICK .............................................. 46
3.2.1.4  Solid Modeling of BASE .......................................................... 47
3.2.1.5  Solid Modeling of UPPER BODY ............................................ 47
3.2.1.6  Solid Modeling of CHAIN ....................................................... 48
3.2.1.7  Solid Modeling of CABIN ....................................................... 48
3.2.1.8  Solid Modeling of COVER ENGINE ......................................... 49
3.2.1.9  Solid Modeling of LINK 1 ....................................................... 49
3.2.1.10 Solid Modeling of LINK 2 ...................................................... 50
3.2.1.11 Solid Modeling of AXLE 1 ..................................................... 50
3.2.1.12 Solid Modeling of AXLE 2 ..................................................... 51
3.2.1.13 Solid Modeling of SMALL ROLLAR ........................................ 51
3.2.1.14 Solid Modeling of ROLLAR TRACK ........................................ 52
3.2.1.15 Solid Modeling of SMALL UPPER ROLLAR TRACK .............. 52
3.2.1.16 Solid Modeling of PISTON SHIFT AND PISTON CASE .......... 53
3.2.1.17 Solid Modeling of PIN CONTACTED ........................................ 53

3.3  Design Phase 2 ........................................................................... 54
3.4  Assembly of EXCAVATOR Parts ................................................. 59

4.  KINEMATICS AND FINITE ELEMENT ANALYSIS OF BUCKET
ATTACHMENT ..................................................................................... 62
4.1  Convert SolidWorks File to STAP File Geometries into SIMWISE 4D .... 62
4.2  Assembly All Part by Using SIMWISE 4D ........................................ 64
4.3  Contact Two Parts by Using SIMWISE 4D ....................................... 66
4.4  Kinematics Analysis of EXCAVATOR ............................................ 69
4.5  Apply Motion for Loading and Dumping Motion for the Bucket Attachment ...... 71
4.6  Mesh Bodies...................................................................................................................... 76

4.7  List of Parts Included in FEA and Their Properties.................................................... 77

5.  CASE STUDIES ................................................................................................................ 84

5.1  Prepare Process for Run FEA ....................................................................................... 85

5.2  Case Study 1 Steel ANSI C 1020................................................................................. 90

5.3  Case Study 2 Hardox - 400 ....................................................................................... 101

5.4  Results......................................................................................................................... 116

References ......................................................................................................................... 117
# LIST OF TABLES

<table>
<thead>
<tr>
<th>Tables</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 2.1 Mechanical Properties of HARDOX - 400 and ANSI C 1020</td>
<td>11</td>
</tr>
<tr>
<td>Table 4.1 Properties of the Bucket</td>
<td>77</td>
</tr>
<tr>
<td>Table 4.2 Properties of the Boom</td>
<td>78</td>
</tr>
<tr>
<td>Table 4.3 Properties of Stick</td>
<td>79</td>
</tr>
<tr>
<td>Table 4.4 Properties of Link 1</td>
<td>80</td>
</tr>
<tr>
<td>Table 4.5 Properties of Link 2</td>
<td>81</td>
</tr>
<tr>
<td>Table 4.6 Properties of Base</td>
<td>82</td>
</tr>
<tr>
<td>Table 5.1 Excavator Specification</td>
<td>91</td>
</tr>
<tr>
<td>Table 5.2 New Weights for Bucket Attachment According to Hardox – 400</td>
<td>102</td>
</tr>
</tbody>
</table>
# LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figures</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1.1 CAT 325 D L Excavator</td>
<td>3</td>
</tr>
<tr>
<td>Figure 2.1 CAT 325 D L Excavator General View</td>
<td>6</td>
</tr>
<tr>
<td>Figure 2.2 Excavator Components</td>
<td>7</td>
</tr>
<tr>
<td>Figure 2.3 First Load Condition: (a) Initial Position (b) Final Position</td>
<td>8</td>
</tr>
<tr>
<td>Figure 2.4 Second and Third Load Conditions Lifting at the Maxima and Minima Distance from Axle of Rotation</td>
<td>9</td>
</tr>
<tr>
<td>Figure 2.5 Fourth Load Condition</td>
<td>10</td>
</tr>
<tr>
<td>Figure 2.6 Hardox – 400 Elastic Limit</td>
<td>12</td>
</tr>
<tr>
<td>Figure 2.7 Hardox – 400 Deformation</td>
<td>12</td>
</tr>
<tr>
<td>Figure 3.1 Photograph and Main Dimension for the Excavator</td>
<td>13</td>
</tr>
<tr>
<td>Figure 3.2 Photograph for Major Component Weights</td>
<td>14</td>
</tr>
<tr>
<td>Figure 3.3 Open New File from File Menu</td>
<td>16</td>
</tr>
<tr>
<td>Figure 3.4 Change Units to CGS</td>
<td>17</td>
</tr>
<tr>
<td>Figure 3.5 Sketch Tab</td>
<td>17</td>
</tr>
<tr>
<td>Figure 3.6 Selected Front Plane</td>
<td>18</td>
</tr>
</tbody>
</table>
Figure 3.7 Draw a Sketch...........................................................................................................19
Figure 3.8 Click Finish Draw....................................................................................................19
Figure 3.9 Extruded Command................................................................................................20
Figure 3.10 Property Manager of Boss-Extrude.......................................................................20
Figure 3.11 Right Symbol to Complete Sketch ........................................................................21
Figure 3.12 3 Dimensional for Boom........................................................................................21
Figure 3.13 Reference Geometry ...............................................................................................22
Figure 3.14 New Plane...............................................................................................................22
Figure 3.15 New Sketch on New plane........................................................................................23
Figure 3.16 Extruded Command................................................................................................23
Figure 3.17 Extruded Head of Boom.........................................................................................24
Figure 3.18 New Sketch inside Head of Boom...........................................................................24
Figure 3.19 Extruded Boss/Base Command .............................................................................25
Figure 3.20 Boss–Extrude Properties .........................................................................................25
Figure 3.21 3 Dimensional for Boom Head ..............................................................................26
Figure 3.22 Scale Command......................................................................................................26
Figure 3.23 Scale Properties .....................................................................................................27

xiii
Figure 3.41 3 Dimensional Bucket after Boss – Extrude .................................................... 36

Figure 3.42 Create New Plane ........................................................................................................ 37

Figure 3.43 Scale Command............................................................................................................ 37

Figure 3.44 New Scale for Bucket ................................................................................................. 38

Figure 3.45 Shell Properties ........................................................................................................... 38

Figure 3.46 Bucket after Shell ......................................................................................................... 39

Figure 3.47 Bucket Handle Sketch ................................................................................................. 39

Figure 3.48 Bucket Handle during Extruded ................................................................................... 40

Figure 3.49 Bucket Handle after Extruded .................................................................................... 40

Figure 3.50 Extruded Cut Sketch for Handle .................................................................................. 41

Figure 3.51 Extruded Cut Command ............................................................................................. 41

Figure 3.52 Extruded Cut for Bucket Handle .................................................................................. 42

Figure 3.53 Mirror Properties for Extruded Cut of Bucket Handle ............................................... 42

Figure 3.54 Bucket after Complete Handle ................................................................................... 43

Figure 3.55 Create New Plane for Teeth ......................................................................................... 43

Figure 3.56 Tooth Sketch ................................................................................................................ 44

Figure 3.57 First Tooth in the Bucket ............................................................................................. 44
Figure 3.58 Linear Pattern for Teeth.................................................................45
Figure 3.59 Fill Out for Teeth........................................................................45
Figure 3.60 Final Geometric for Bucket.........................................................46
Figure 3.61 Stick..............................................................................................46
Figure 3.62 Base ..............................................................................................47
Figure 3.63 Body ..............................................................................................47
Figure 3.64 Chain............................................................................................48
Figure 3.65 Cabin ............................................................................................48
Figure 3.66 Cover Engine ...............................................................................49
Figure 3.67 Link1 ............................................................................................49
Figure 3.68 Link 2 ..........................................................................................50
Figure 3.69 Axle 1 ..........................................................................................50
Figure 3.70 Axle 2 ..........................................................................................51
Figure 3.71 Small Roller ................................................................................51
Figure 3.72 Roller Track ................................................................................52
Figure 3.73 Small Upper Roller Track ...............................................................52
Figure 3.74 Piston Shift ..................................................................................53
Figure 3.75 Piston Case ................................................................. 53

Figure 3.76 Pin Contacted .................................................................. 53

Figure 3.77 New SOLIDWORKS Document ........................................ 54

Figure 3.78 Insert Components .......................................................... 54

Figure 3.79 Truck Roller and Body Parts .............................................. 55

Figure 3.80 Service 1 on Body and 2 on Truck Roller ............................. 55

Figure 3.81 Mate Window .................................................................... 56

Figure 3.82 Service 3 on Body and 4 on Truck Roller ............................. 56

Figure 3.83 Final Assembly for Body and Truck Roller for Excavator ....... 57

Figure 3.84 Upper Body: Body, Cabin, Base and Cover Engine .............. 57

Figure 3.85 Bottom Body : Track, Chain, Motor and Roller .................. 58

Figure 3.86 Bucket Attachment: Bucket, Stick, Boom, Damper, Link 1 and
Link 2 ................................................................................................. 58

Figure 3.87 Isometric View .................................................................. 59

Figure 3.88 Side View of Excavator Assembly .................................... 60

Figure 3.89 Back View of Excavator Assembly .................................... 60

Figure 3.90 Front View of Excavator Assembly .................................... 61
Figure 4.1 SOLIDWORKS File ...........................................................................................................62
Figure 4.2 Save as SOLIDWORKS Part File to STEP File.........................................................63
Figure 4.3 Prepare to Open the File with SIMWISE 4D ...............................................................63
Figure 4.4 Open the File with SIMWISE 4D ................................................................................64
Figure 4.5 Open the File ................................................................................................................64
Figure 4.6 Coord Command ..........................................................................................................65
Figure 4.7 Coord Position ..............................................................................................................65
Figure 4.8 Two Parts of SIMWISE 4D ..........................................................................................66
Figure 4.9 Select Two Coords ......................................................................................................66
Figure 4.10 Create Constraint ......................................................................................................67
Figure 4.11 Create Constraint Options ........................................................................................67
Figure 4.12 Final 3 Dimensional Model after Connecting Body with Track ................................68
Figure 4.13 Final 3 Dimensional Model .........................................................................................68
Figure 4.14 Excavator Assembly in SimWise 4D .........................................................................69
Figure 4.15 Bucket, Stick and Boom Cylinders ..........................................................................70
Figure 4.16 Right Click on Bucket Cylinder ................................................................................71
Figure 4.17 Properties Menu ........................................................................................................71
Figure 4.18 Insert Values for Bucket Cylinder ................................................................. 72
Figure 4.19 Edit Table Menu .......................................................................................... 72
Figure 4.20 Value Motion for Boom Cylinder ................................................................. 73
Figure 4.21 Value Motion for Stick Cylinder ................................................................. 74
Figure 4.22 Value Motion for Bucket Cylinder .............................................................. 75
Figure 4.23 Bucket Properties ....................................................................................... 76
Figure 4.24 Bucket Properties Window ......................................................................... 76
Figure 4.25 Bucket with Generated Mesh ...................................................................... 77
Figure 4.26 Boom with Generated Mesh ......................................................................... 78
Figure 4.27 Stick with Generated Mesh .......................................................................... 79
Figure 4.28 Link 1 with Generated Mesh ........................................................................ 80
Figure 4.29 Link 2 with Generated Mesh ........................................................................ 81
Figure 4.30 Base with Generated Mesh .......................................................................... 82
Figure 4.31 3 Dimensional Model with Generated Mesh ............................................... 83
Figure 5.1 Second and Third Load Condition: Lifting at the Maxima and
Minima Distance from Axle of Rotation ........................................................................ 84
Figure 5.2 Material Properties for Bucket ..................................................................... 85
Figure 5.20 The Result of the Displacement ................................................................. 98
Figure 5.21 The Result of the Displacement at .04 Sec .............................................. 99
Figure 5.22 The Result of the Displacement at 0.2 Sec .............................................. 99
Figure 5.23 The Result of the Displacement at 0.36 Sec .......................................... 100
Figure 5.24 Hardox – 400 Properties ......................................................................... 101
Figure 5.25 New Design for Bucket .......................................................................... 102
Figure 5.26 Old Design for Bucket ............................................................................ 103
Figure 5.27 The Result of the Stress in Hardox – 400 ................................................. 104
Figure 5.28 The Result of the Stress for Hardox – 400 and Steel ANSI C 1020 ......... 105
Figure 5.29 The Result of the Stress at 0 Sec ............................................................ 106
Figure 5.30 The Result of the Stress at 0.2 Sec .......................................................... 106
Figure 5.31 The Result of the Stress at 0.34 Sec ......................................................... 107
Figure 5.32 The Result of the Strain in Hardox – 400 ............................................... 108
Figure 5.33 The Result of the Strain for Hardox – 400 and Steel ANSI C 1020
     Displacement .......................................................................................................... 109
Figure 5.34 The Result of the Strain at 0 Sec ............................................................. 110
Figure 5.35 The Result of the Strain at 0.2 Sec .......................................................... 110
Figure 5.36 The Result of the Strain at 0.34 Sec ..........................................................111

Figure 5.37 The Result of the Displacement in Hardox – 400........................................112

Figure 5.38 The Result of the Displacement for Hardox – 400 and Steel ANSI C 1020 ..... 113

Figure 5.39 The Result of the Displacement at 0 Sec ...................................................114

Figure 5.40 The Result of the Displacement at 0.2 Sec ...............................................114

Figure 5.41 The Result of the Displacement at 0.34 Sec ...............................................115
Chapter 1

INTRODUCTION

1.1 PROBLEM STATEMENT

Hydraulic excavator has defined as a multi-functional construction machine. Workers in the construction industry use it for jobs such as excavating, dumping, finishing, lifting work, etc. A hydraulic excavator contains three links, which are boom, arm and bucket. The excavator, which was examined in this thesis, is a classical machine represented in Fig. 1.1. The power for this excavator is 110 kW, the rated weight is about 30,000 kg, and the maximum load operation is 25000 Pa. This machine mainly used to demolish and move material in applications concerning civil and industrial field.

Since the productivity per hour of the machine is correlated to the volumetric capacity of the bucket. The main purpose of this thesis is to make the stick and boom stronger and lighter in order to allow the use of a bigger bucket in comparison with the original one, by using Hardox 400 instead of steel, which usually use to make these attachments. The excavator mechanism must work reliably under unpredictable working conditions. Poor strength properties of the excavator parts like the boom, stick and bucket can limit the life expectancy of the excavator. Therefore, excavator parts must be strong enough to perform its job under caustic working conditions. There are different types of terrains and exerted soil and tool interaction forces may vary as per the terrain condition. Thus, it is a challenging job to design such an excavator, which can work in unpredictable environments and be used for prolonged periods of time with all kinds of forces used
without any kind of failure. For the design engineer it is not enough to provide robust
design but also taking care of the weight of the attachment for better controlling during
excavation operation. This work can be divided into different steps. The first step is to
introduce the excavator and its properties. The second step, is designing the excavator using
SolidWorks.

The third step is to use the SIMWISE 4D to analyze all the parts that are been made
using SOLDWORKS. After that, we setup the motion for bucket attachment at maximum
load condition as we explained in the first step and prepare the new and old design to
analysis by using the finite element method. During the work cycle, a backhoe must
accelerate and move at a constant speed and decelerate. The time-varying position and
orientation of the backhoe is termed as its dynamic behavior. Time-varying torques are
applied at the joints (by the joint actuators) to balance out the internal and external forces.
The fourth step is analyzing the old design for bucket by using the original specification of
the excavator with steel alloy material. The fifth step is to analyze a new design for the
bucket with new specifications, which comes from applying new material “Hardox–400”.
The final step is to compare the stress strain and displacement for original material Steel
ASAI C 1020 with another one in the Hardox – 400. The results can help us to make the
excavator stronger and lighter, we can also decrease the weight for boom and stick to half
of its current weight and increases the bucket capacity from 0.65m³ to 1.07m³ with
maximum operation load 30000 Pa instead of 25000 Pa in the Steel ANSI C-1020. In other
words, we can make the excavator more efficient with better properties.
1.2 FINITE ELEMENT METHOD

Finite Element Analysis (FEA) is a tool used for the evaluation of structures and systems, providing an accurate prediction of a component’s response when subjected to thermal and structural loads. Structural analyses include all types of steady or cyclic loads, mechanical or thermal. Thermal analyses include convection, conduction, and radiation heat transfer as well as various thermal transients and thermal shocks. FEA was largely developed in the 1950’s by aerospace engineers to design better aircraft structures. Since then, aided by the rapid growth of computing power, the method has continually developed, and is now the tool of choice for technical analysis by mechanical, civil, biomechanical, and other engineers.
• It is a very accurate tool used for failure analysis purposes.
• Used to quantify design defects, fatigue, buckling, and code compliance.
• Can be used to distinguish between failures due to design deficiencies, materials defects, fabrication errors, and abusive use.
• It provides quantified results previously based on metallurgical and mechanical testing.
• It provides excellent visual aids and animations easily understood by juries. [1]

1.3 SOFTWARE USED

The first software it will be used in this thesis is SOLDWORKS. SOLDWORKS is a 3D mechanical CAD (computer-aided-design) program and was established and Dassault Systèmes SolidWorks Corp. Over 2 million engineers and more than 165,000 companies worldwide designer use this software. SolidWorks Corporation was established in December 1993 by Massachusetts Institute of Technology graduate Jon Hirsch tick. SolidWorks is a Parasolid-based modeled, and utilizes a parametric feature-based approach to create models and assemblies. [2]

The next software that will be used in this thesis, will be SIMWISE 4D. SIMWISE 4D is a software tool that allows the functional performance of mechanical parts and assemblies to be simulated and validated. It combines 3D multi-body dynamic motion simulation with 3D finite element analysis in a Windows based, CAD neutral product, priced affordably for every engineer.
All of the SIMWISE 4D products are independent of any CAD system. Simple geometry, suitable for creating basic design layouts, can be created within SIMWISE 4D. The detailed geometry required for accurate simulation can be imported from most major CAD systems. SIMWISE 4D can directly read files created by Catia V5, Creo Elements/Pro, SolidWorks, Solid Edge, Autodesk Inventor, and Siemens NX. Additionally IGES, STEP, ACIS, and Parasolids files can be read. SIMWISE FEA is a Finite Element Analysis tool that performs stress, normal modes, buckling, and heat transfer analysis on mechanical parts. [3]
Chapter 2

BACKGROUND OF THE STUDY

2.1 WHAT IS AN EXCAVATOR?

A hydraulic Excavator is a mobile machine that is moved by means of either crawler track or rubber-tired undercarriage. It has a unique feature that its upper structure is capable full rotation, and thus it has a useful working range. A hydraulic excavator is the most commonly used construction machine. It has a bucket with specified volumetric capacity. It can work above and below the ground level. Excavator digs, elevates, swings and dumps material by the action of its mechanism, which consists of boom, stick, bucket, link and hydraulic cylinders. The bucket can be used for trenching in the placement of pipe and other under-ground utilities, digging basements, water retention ponds, maintaining slopes and mass excavation.

Figure 2.1 CAT 325 D L Excavator General View
Due to severe working conditions, excavator parts are subject to corrosive effects and high loads. The excavator mechanism must work reliably under unpredictable working conditions. Consequently, excavator parts must be strong enough to contend with caustic working conditions of the excavator.

2.2 WHAT DOES AN EXCAVATOR CONSIST OF?

An excavator consists of various major components and has different fittings so it can work well. The main components of the excavator are made with durability and high strength so that it can withstand the severe operating conditions for a long time. The main components of the excavator are shown in figure 2.2.

Figure 2.2 Excavator Components
2.3 HOW DOES EXCAVATOR WORK?

Operating conditions for the hydraulic excavator mechanism are categorized into five types. All operation conditions depend on two elements. The first element is the distance between the axis of rotation and the teeth of bucket. The second element is the side force, tangential force and gravity force:

Operating Condition 1: The cylinder of the working stick retracts completely. The cylinder of the bucket rod has the greatest force stick; the tips of the teeth are on the extended line of the line segment passing through the joint of bucket and bucket rods, joint of bucket rod and working stick. Under this condition, the load is composed of gravity, tangential force and side force as shown in the figure 2.3.

![Figure 2.3 First Load Condition: (a) Initial Position (b) Final Position](image)
Operating Condition 2 and 3: Cylinders of the working stick and the bucket rod have the greatest force. The tips of the teeth are on the extended line of the line segment passing through the joint of the bucket and bucket rod, and the joint of bucket rod and working arm. The load is composed of gravity and tangential force. On the other hand, the Operating Condition 3 Cylinders of the working stick and the bucket rod have the greatest force stick; the cylinder of the bucket operates at maximum equivalent force stick. The load is composed of gravity and tangential force as shown in the figure 2.4.

Figure 2.4 Second and Third Load Conditions Lifting at the Maxima and Minima

Distance from Axle of Rotation
Operating Condition 4: The Cylinder of the working stick retracts completely, the tips of teeth are on the extended line of the line segment passing through the joint of bucket and bucket rod, and the joint of bucket rod and working stick. The three points are all on the plumb line. The load is composed of gravity, tangential force and side force as shown in the figure 2.5.

![Figure 2.5 Fourth Load Condition](image)

Operating Condition 5: Cylinder of the bucket rod retracts completely. The cylinder of the working stick ensures that the working stick and bucket rod operate at a position furthest away from the axis of rotation. The cylinder of the bucket extends to its maximum length, enabling the bucket to take up loads. The load is composed of gravity and inertial braking moment. [4]
2.4 WHAT IS HARDOX – 400?

HARDOX – 400 is the brand name for wear resistant plates made by SSAB in Sweden. HARDOX – 400 is an abrasion resistant plate with a hardness of 400 HBW, intended for applications where demands imposed on abrasion resistance are high in combination with good cold bending properties. HARDOX – 400 offers very good weld ability. [5]

2.5 COMPARISON BETWEEN THE PROPERTIES OF HARDOX – 400 AND STEEL ANSI C 1020

Two types of materials are used for the different parts of the bucket assembly as shown in table 2.5. Hardox - 400 wear steel has unique properties for digger buckets. Hardox combines high hardness with valuable workability properties. This means that the bucket will last longer (SSAB, 2012).

<table>
<thead>
<tr>
<th>Sr.</th>
<th>Property</th>
<th>Value</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Steel ANSI C</td>
<td>Hardox -400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Density</td>
<td>7850</td>
<td>7473.57</td>
<td>Kg</td>
</tr>
<tr>
<td>2</td>
<td>Modulus of elasticity</td>
<td>200000</td>
<td>210000</td>
<td>Mp</td>
</tr>
<tr>
<td>3</td>
<td>Poisson’s ratio</td>
<td>0.3</td>
<td>0.29</td>
<td>--</td>
</tr>
<tr>
<td>4</td>
<td>Yield strength</td>
<td>250</td>
<td>1000</td>
<td>Mp</td>
</tr>
<tr>
<td>5</td>
<td>Ultimate tensile strength</td>
<td>410</td>
<td>1250</td>
<td>Mp</td>
</tr>
</tbody>
</table>

Table 2.1 Mechanical Properties of HARDOX - 400 and ANSI C 1020
Therefore, the benefit of using HARDOX-400 instead of STEEL ANSI C 1020 is:

1. Higher elastic limit and higher ultimate stress as shown in Figure (2.6).

![Figure 2.6 Hardox – 400 Elastic Limit](image)

5. Longer life span (higher resistance to deformation, abrasion and scratching) as shown in Figure

![Figure 2.7 Hardox – 400 Deformation](image)

3. Excellent resistance to impact.

4. Less corrosion and cracking risks.

5. Lower empty weight and better air resistance = less consumption [6].
Chapter 3
SOLID MODELING OF EXCAVATOR

3.1 EXCAVATOR SPECIFICATION

The Series family of excavators have become the industry standard in general, quarry, and heavy construction applications. The CAT 325 D will continue that trend-setting standard. The CAT 325 D meets current U.S. EPA Tier 4 Interim emission standards. It is built with several new fuel-saving, comfort-enabling features and benefits that will delight owners and operators. [7]

![Dimensions Diagram]

Figure 3.1 Photograph and Main Dimension for the Excavator
### Machine and Major Component Weights

Actual weights and ground pressures will depend on final machine configuration.

<table>
<thead>
<tr>
<th>Component</th>
<th>Reach boom</th>
<th>ME 5000 mm</th>
<th>VA boom 8000 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reach boom 6730 mm</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stick type</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stick length</td>
<td>mm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bucket weight</td>
<td>kg</td>
<td>1314</td>
<td>975 884</td>
</tr>
<tr>
<td>Bucket capacity</td>
<td>m³</td>
<td>1.6</td>
<td>1.5 1.25</td>
</tr>
<tr>
<td>Bucket width/Type</td>
<td>mm</td>
<td>1350/1400X</td>
<td>1300/X 1350/EX</td>
</tr>
<tr>
<td>Operating weight*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>325D L (800 mm shoes)</td>
<td>kg</td>
<td>30 110</td>
<td>25 115 30 620</td>
</tr>
<tr>
<td>325D LN (600 mm shoes)</td>
<td>kg</td>
<td>29 140</td>
<td>28 540 30 330</td>
</tr>
<tr>
<td>Ground pressure</td>
<td>bar</td>
<td>0.44 0.35</td>
<td>0.44 0.44 0.44</td>
</tr>
<tr>
<td>325D L (800 mm shoes)</td>
<td>bar</td>
<td>0.35</td>
<td>0.36 0.57 0.58</td>
</tr>
<tr>
<td>325D LN (600 mm shoes)</td>
<td>bar</td>
<td>0.56</td>
<td>0.56 0.57 0.57</td>
</tr>
<tr>
<td>Stick weight (without bucket cylinder)</td>
<td>kg</td>
<td>900 840</td>
<td>945 900 840</td>
</tr>
<tr>
<td>Boom weight (without stick cylinder)</td>
<td>kg</td>
<td>1770</td>
<td>1830 2650</td>
</tr>
<tr>
<td>Upperstructure (without counterweight)</td>
<td>kg</td>
<td>5770</td>
<td>6770 5770</td>
</tr>
<tr>
<td>Undercarriage</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>325D L (800 mm shoes)</td>
<td>kg</td>
<td>11 400</td>
<td>11 400 11 400</td>
</tr>
<tr>
<td>325D LN (600 mm shoes)</td>
<td>kg</td>
<td>10 380</td>
<td>10 380 10 380</td>
</tr>
<tr>
<td>Counterweight</td>
<td>kg</td>
<td>5810</td>
<td>5810 5810</td>
</tr>
</tbody>
</table>

* With counterweight, quick coupler, bucket, operator and full fuel.

Figure 3.2 Photograph for Major Component Weights
3.2 DESIGN PHASE 1

As this thesis is based on reverse engineering, I needed a reference to get the detailed dimensions of an excavator to create a 3D model. To get the data from any EXCAVATOR manufacturing company is a daunting task and even if I could get it from somewhere, it will not possible to disclose here in this thesis. To overcome this situation, I Reverse Engineering approach use need using an EXCAVATOR Toy from AMAZON.COM SCAL 1-87 beside the original cartilage for this kind of Excavator. I disassembled a toy into small but meaningful parts and measured the dimensions of those parts with the help of vernier caliper and ruler. After measuring all the parts, I started creating a 3D model of those parts into SOLDWORKS.

3.2.1 3D MODELING OF EXCAVATOR PARTS

As mentioned above, SolidWorks has been used to meet 3D modeling needs of this thesis. I have explained below how to create a 3D model from scratch for three parts of the boom and bucket. The list of parts has been listed below. Figure 3.3 to Figure3.76 shows the 3D Model of all the components.
3.2.1.1 SOLID MODELING OF BOOM

1) Open SOLIDWORKS.

2) Click NEW from tab and select “Part” in new solid work window as shown in the Figure 3.3.

![Figure 3.3 Open New File from File Menu](image)

3) It will open a new file with desktop interface for solid work.
4) Change Units to CGS (centimeter, gram, second) in the right below corner of desktop solid work as shown in the Figure 3.4 Change Units to CGS.

![Figure 3.4 Change Units to CGS](image)

5) Click on sketch on the Tool Menu as shown in the Figure 3.5.

![Figure 3.5 Sketch Tab](image)
5) Choose the front plane to start the drawing as shown in the Figure 3.6 selected Front Plane.
7) Draw a sketch, apply necessary dimensions and make the sketch fully constrained. All the sketch entities will turn into black color once fully defined which has shown in the Figure 3.7.

![Figure 3.7 Draw a Sketch.](image)

8) Once you are done with drawing a sketch, click on finish sketch symbol at upper right corner as shown in the Figure 3.8.

![Figure 3.8 Click Finish Draw](image)
9) Click on Features toolbar and click on Extruded Boss/Base as shown in Figure 3.9.

![Figure 3.9 Extruded Command](image)

10) In Property Manager of Boss-Extrude, select the options shown in the Figure 3.10.

![Figure 3.10 Property Manager of Boss-Extrude](image)

11) Sketch of the Boom will become 3 Dimensional.
12) Once you are done with drawing a sketch, Click on right symbol on upper right corner of the file as shown in the Figure 3.11.

![Figure 3.11 Right Symbol to Complete Sketch.](image)

13) Figure 3.12 after successfully completing the extruded command a 3 Dimensional drawing of the Boom is showing.

![Figure 3.12 3 Dimensional for Boom](image)
14) Create a new plane by going to the Reference Geometry and plane as shown in the Figure 3.13.

Figure 3.13 Reference Geometry

15) Click on the front face of the boom to be the new Reference for new plane as shown in the Figure 3.14.

Figure 3.14 New Plane
16) Now, we start new sketch on the new plane, which has shown in the Figure 3.15.

![Figure 3.15 New Sketch on New Plane.](image)

17) Click on Extruded Cut feature on feature toolbar as shown in Figure 3.16.

![Figure 3.16 Extruded Command.](image)
18) On the left side of the boom put 0.85cm and click ok as shown in the Figure 3.17.

![Figure 3.17 Extruded Head of Boom](image)

19) Click inside the surface as shown in the Figure 3.18 New sketch inside head of the Boom and click then sketch new drawing.

![Figure 3.18 New Sketch inside Head of Boom](image)
20) Click on Features toolbar and click on Extruded Boss/Base as shown in Figure 3.19.

![Figure 3.19 Extruded Boss/Base Command](image1)

21) In Boss–Extrude select Direction 1 and choose “up to the next” as shown in the Figure 3.20.

![Figure 3.20 Boss–Extrude Properties](image2)
22) Click ok; it will complete the process as shown in the Figure 3.21.

![Figure 3.21 3 Dimensional for Boom Head](image)

23) Click in file menue → insert → model Scale as shown in the Figure 3.22.

![Figure 3.22 Scale Command](image)
24) Write 87 in the Scale parameters “1:87th Scale for small model using to model this kind of excavator” as shown in the Figure 3.23.

![Figure 3.23 Scale Properties](image)

25) Click on the face of boom and click on comment shell as shown in the Figure 3.24.

![Figure 3.24 Shell Command](image)
26) Click on shell and put 5 cm as thickness for the boom as shown in the Figure 3.25.

![Figure 3.25 Shell Properties](image)

27) Click ok to finish this process, it will show the boom after shell, which has shown in the Figure 3.26.

![Figure 3.26 Boom after Shell Process](image)
28) Click inside the boom and click on the sketch in the main tab to start new draw as shown in the Figure 3.27.

![Figure 3.27 Boom Support Sketch](image)

29) After that, do the extruded step 28 and click ok it will show the support boom as shown in the Figure 3.28.

![Figure 3.28 Boom Support](image)
30) Click on the outer edge of the boom and start a new sketch as shown in the figure

Figure 3.29.

31) It will generate a sketch on the top surface of the boom by using Convert entities as shown in the Figure 3.30.

Figure 3.29 Outside Sketch for Boom

Figure 3.30 Fillet Right Side of Boom
32) On the left hand side, in Property Manager of Boss – Extrude, in Direction 1 “inside the boom”, enter 5 cm as a required length and click on right symbol in upper right corner of the file as shown in the Figure 3.31.

Figure 3.31 Final Geometric for Boom
3.2.1.2 SOLID MODELING OF BUCKET

1) Open SolidWorks. Click new from tab, choose 3d part, and click ok as shown in the Figure 3.32.

![Figure 3.32 Open New File from File Menu](image)

2) It will open a new file with desktop for solid work.

3) Change Unit to MMGS (millimeter, gram, second) as shown in the Figure 3.33.

![Figure 3.33 Change Unit to MMGS](image)
4) Click on sketch on the Tool Menu as shown in the Figure 3.34.

![Figure 3.34 Sketch Command](image)

5) Choose the front plane to start the drawing as shown in the Figure 3.35.

![Figure 3.35 Select Front Plane](image)
6) Draw a sketch; apply necessary dimensions, which has shown in the Figure 3.36.

![Figure 3.36 Bucket Sketch](image)

7) Once you are done with drawing the sketch, click on finish sketch symbol in upper right corner as shown in the Figure 3.37.

![Figure 3.37 Sketch Symbol at Upper Right Corner](image)
8) Click on Features toolbar and click on Extruded Boss/Base as shown in Figure 3.38.

![Figure 3.38 Extruded Command](image)

9) In Property Manager of Boss-Extrude, select the options middle plane and put 18 mm as shown in the Figure 3.39.

![Figure 3.39 Boss – Extrude for Bucket](image)
10) Once you are done with drawing the sketch, Click on the right symbol in upper right corner of the file as shown in the Figure 3.40.

![Figure 3.40 Right Symbol to Complete Sketch.](image)

11) Figure 3.41 is showing the view of the Bucket after successfully completing the extruded command.

![Figure 3.41 3 Dimensional Bucket after Boss – Extrude](image)
12) Now create a new plane by going to the Reference Geometry and plane as shown in the Figure 3.42.

![Figure 3.42 Create New Plane](image)

13) Click on file menu and insert a model Scale as shown in the Figure 3.43.

![Figure 3.43 Scale Command](image)
14) Now put 87 in the Scale parameters “1:87th scale for small model used to model this kind of excavator” as shown in the Figure 3.44.

![Figure 3.44 New Scale for Bucket](image)

15) Click on the face of Bucket and click on comment shell. After clicking on shell put 70mm as a thickness as shown in the Figure 3.45.

![Figure 3.45 Shell Properties](image)
16) Click ok to finish this process Figure 3.46.

![Figure 3.46 Bucket after Shell](image)

17) Click on the outside of the Bucket and click on the sketch in the menu to start new drawing as shown in the Figure 3.47.

![Figure 3.47 Bucket Handle Sketch.](image)
18) After that use the extruded command to extrude this sketch and click ok as shown in the Figure 3.48.

![Figure 3.48 Bucket Handle during Extruded](image1)

19) Click ok to finish this process, it will show bucket with handle as shown in the Figure 3.49.

![Figure 3.49 Bucket Handle after Extruded](image2)
20) Now click on the same service in step 19 and start new sketch as shown in Figure 3.50.

21) Click on Convert Entities to help you draw same sketch in step 18.

22) Click on Extruded Cut feature on feature toolbar as shown in Figure 3.51.

Figure 3.50 Extruded Cut Sketch for Handle

Figure 3.51 Extruded Cut Command.
23) On the cut-extruded box put 400 mm and click ok as shown in Figure 3.52.

![Figure 3.52 Extruded Cut for Bucket Handle](image)

Figure 3.52 Extruded Cut for Bucket Handle

24) Click on the Mirror command and take “front plane” as reference and click ok as shown in the Figure 3.53.

![Figure 3.53 Mirror Properties for Extruded Cut of Bucket Handle](image)

Figure 3.53 Mirror Properties for Extruded Cut of Bucket Handle
25) Click on the front plane and start new sketch by using command “convert entities “and do the Extruded cut for Bucket handle for two directions .Click on Extruded Cut feature on feature toolbar in the Direction 1 middle plane and put 400 mm and click ok as shown in Figure 3.54.

![Figure 3.54 Bucket after Complete Handle](image)

26) To make the teeth for the bucket create a new plane as shown in Figure 3.55.

![Figure 3.55 Create New Plane for Teeth](image)
27) Create new sketch on the new plane as shown in the Figure 3.56.

Figure 3.56 Tooth Sketch

28) Extrude the sketch in step 27 and click ok, it will show the first tooth in the bucket as shown in the Figure 3.57.

Figure 3.57 First Tooth in the Bucket
29) Now make 7 teeth total, click on “linear pattern“ and put 200 mm distance between each tooth and click ok as shown in the Figure 3.58.

![Figure 3.58 Linear Pattern for Teeth](image)

30) After completion of the linear pattern the teeth are filled in as shown in the Figure 3.59.

![Figure 3.59 Fill Out for Teeth](image)
31) Final Geometric for Bucket as shown in the Figure 3.60.

Figure 3.60: Final Geometric for Bucket

3.2.1.3 SOLID MODELING OF STICK

Figure 3.61 Stick
3.2.1.4 SOLID MODELING OF BASE

Figure 3.62 Base

3.2.1.5 SOLID MODELING OF UPPER BODY

Figure 3.63 Body
3.2.1.6 SOLID MODELING OF CHAIN

Figure 3.64 Chain

3.2.1.7 SOLID MODELING OF CABIN

Figure 3.65 Cabin
3.2.1.8 SOLID MODELING OF COVER ENGINE

Figure 3.66 Cover Engine

3.2.1.9 SOLID MODELING OF LINK 1

Figure 3.67 Link 1
3.2.1.10 SOLID MODELING OF LINK 2

Figure 3.68 Link 2

3.2.1.11 SOLID MODELING OF AXLE 1

Figure 3.69 Axle 1
3.2.1.12 SOLID MODELING OF AXLE 2

Figure 3.70 Axle 2

3.2.1.13 SOLID MODELING OF SMALL ROLLER

Figure 3.71 Small Roller
3.2.1.14 SOLID MODELING OF TRACK ROLLER

![Figure 3.72 Track Roller](image1)

3.2.1.15 SOLID MODELING OF SMALL UPPER ROLLER TRACK

![Figure 3.73 Small Upper Roller Track](image2)
3.2.1.16 SOLID MODELING OF PISTON SHIFT AND PISTON CASE

Figure 3.74 Piston Shift

Figure 3.75 Piston Case

3.2.1.17 SOLID MODELING OF PIN CONTACTED

Figure 3.76 Pin Contacted
3.3 DESIGN PHASE 2

Design phase 2 is all about Assembly all parts together by these step:

1) Open SOLIDWORKS Program

2) Click File→ New→ Assembly → OK, as shown in the Figure 3.77.

![Figure 3.77 New SOLIDWORKS Document](image)

3) Click on in the Main Tab then click Browse and select the Truck Roller Part then, click as shown in the Figure 3.78.

![Figure 3.78 Insert Components](image)
4) Repeat steps 1 and 2 to insert body part as shown in the Figure 3.79.

![Figure 3.79 Truck Roller and Body Parts](image)

5) Click in Mate then, Select the service 1 in the body and service 2 in the truck roller as shown in the Figure 3.80.

![Figure 3.80 Service 1 on Body and 2 on Truck Roller](image)
6) Click on Concentric in the Mate and click ok as shown in the Figure 3.81.

![Figure 3.81 Mate Window](image)

Figure 3.81 Mate Window

7) Click on the service 3 in the body and service 4 in the truck roller as shown in the Figure 3.82.

![Figure 3.82 Service 3 on Body and 4 on Truck Roller](image)
8) Select coincident in the Mate Window and click OK then, we will Finish Assembly body with truck roller as shown in the Figure 3.83.

![Figure 3.83 Final Assembly for Body and Truck Roller for Excavator](image)

9) Finally, repeat 1 to 8 with each all parts in Excavator to assembly upper body, bottom body and bucket attachment as shown in the Figure 3.84, Figure 3.85 and Figure 3.86 respectively.

![Figure 3.84 Upper Body: Body, Cabin, Base and Cover Engine](image)
Figure 3.85 Bottom Body: Track, Chain, Motor and Roller

Figure 3.86 Bucket Attachment: Bucket, Stick, Boom, Damper, Link 1 and Link 2
3.4 ASSEMBLY OF EXCAVATOR PARTS:

Figure 3.87, Figure 3.88, Figure 3.89 and Figure 3.90 shows the assembly model of the Excavator.

Figure 3.87: Isometric View
Figure 3.88 Side View of Excavator Assembly

Figure 3.89 Back View of Excavator Assembly
Figure 3.90 Front View of Excavator Assembly
Chapter 4

KINEMATICS AND FINITE ELEMENT ANALYSIS OF BUCKET ATTACHMENT

In this chapter, we prepare the design to FEA by using SimWise 4D Program. This chapter starts by transferring the Solidwork file to the SimWise 4D file, which define as STEP file, because the Most of the current designing and analysis software allow direct import of geometry from designing software to analysis software through Application Programming Interface (API). However, there is some designing software does not have any support for direct import of geometry? In that case, engineers have to manually convert geometries one by one in known file format like IGES or STEP. Finally, we will show a list of parts and properties that have been included in Finite Element Analysis.

4.1 CONVERT SOLIDWORKS FILE TO STEP FILE GEOMETRIES IN SIMWISE 4D:

1) Open any part file in SolidWorks which you want to convert into Step AP203 file format. Click on File → Save As option. It will open Save As dialog box. As shown in the Figure 4.1.

![Figure 4.1 SOLIDWORKS File](image)
2) In Save As dialog box, keep the file name as it is while change the Save as Type to STEP AP203 or STEP AP214 as per your requirements. Also check the box for Save as Copy as shown in the Figure 4.2.

![Figure 4.2 Save as SOLIDWORKS Part File to STEP File](image)

3) Now, open SIMWISE 4D Program. Click on Insert → File. Then click it, it will open a dialog box as shown in the Figure 4.3. Select any file that you want to open. Checkbox button for Specify length unit and select meter (m) from drop down list. Click open.

![Figure 4.3 Prepare to Open the File with SIMWISE 4D](image)
4) Click save after that. Repeat steps 1 to 4 with all parts as shown in the Figure 4.4.

![Figure 4.4 Open the File with SIMWISE 4D](image)

4.2 ASSEMBLE ALL PARTS BY USING SIMWISE 4D

1) Open new file in the SIMWISE 4D and Click on Insert ➔ File after that select the file that you want as shown in the Figure 4.5.

![Figure 4.5 Open the File](image)
2) Click Coord in the top bar as shown in the Figure 4.6.

Figure 4.6 Coord Command

3) Click on any surface it will connect with another file. As shown in the Figure 4.7 and do that with all parts.

Figure 4.7 Coord Position
4.3 CONTACT TWO PARTS BY USING SIMWISE 4D

1) Insert two part as shown in the Figure 4.8.

2) Click on each Coord in the two part by holding ctrl key as shown in the Figure 4.9.
5) Click on create constraint as shown in the Figure 4.10.

![Figure 4.10 Create Constraint](image1)

4) It will open dialog box select Join or face to face as shown in the Figure 4.11.

![Figure 4.11 Create Constraint Options](image2)
5) Click create it will connect two parts together as shown in the Figure 4.12.

![Figure 4.12 Final 3 Dimensional Model after Connecting Body with Track](image)

6) Repeat steps 1 to 6 with all parts as shown in the Figure 4.13.

![Figure 4.13 Final 3 Dimensional Model](image)
4.4 KINEMATICS ANALYSIS OF EXCAVATOR:

“Kinematics is the branch of classical mechanics or mechanical engineering that describes the motion of bodies (objects) and systems (groups of objects) without consideration of the forces that cause the motion.” [9]

In this Thesis, the kinematic analysis and apply forces has been done with the help of the SimWise 4D program. The core purpose of kinematic analysis was to comprehend whether the assembly performs the loading and dumping motion flawlessly or not. Figure 4.14 shows Excavator assembly in SIMWISE 4D.

Figure 4.14 Excavator Assembly in SimWise 4D.
The excavator has three hydraulic cylinders. These cylinders are boom cylinder, stick cylinder, and bucket cylinder. These cylinders help the bucket attachment to load and dump the load. Figure 4.15 shows all above-mentioned parts more closely.

Figure 4.15 Bucket, Stick and Boom Cylinders
4.5 APPLY THE MOTION FOR LOADING AND DUMPING MOTION FOR BUCKET ATTACHMENT

Now, to perform the loading and dumping motion of the bucket, follow the following steps:

1) Point the mouse on the boom cylinder, double left click, it will open properties menu as shown in the Figure 4.16.

![Figure 4.16 Right Click on Bucket Cylinder](image)

2) Click on actuator tab in properties menu, and select lengths/displacement in actuator and check the box “point to point“ as shown in Figure 4.17.

![Figure 4.17 Properties Menu](image)
3) Click on small tab as shown in the Figure 4.18.

![Value: input[258] ...]

Figure 4.18 Insert Values for Bucket Cylinder

4) It will open edit table menu as shown in the Figure 4.19.

![Edit Table Menu]

Figure 4.19 Edit Table Menu
5) Start the motion for this cylinder by inserting the time from 0 to 0.8 and value displacement from 2.05 to 2.85 as shown in the Figure 4.20.

![Graph of Value Motion for Boom Cylinder](image)

**Figure 4.20 Value Motion for Boom Cylinder**

6) Figure 4.20 shows the graph of above tabulated values with time (s) and length of actuator (m).

7) Click OK, on edit table menu. Click on Apply and close the properties menu.

8) Repeat step 1-7 for second boom cylinder.

9) For stick cylinder, repeat step 1-5.
10) Step the motion for this cylinder by inserting the time from 0 to 0.8 and value displacement from 2.66 to 3.46.

![Figure 4.21 Value Motion for Stick Cylinder](image)

Figure 4.21 Value Motion for Stick Cylinder

11) Figure 4.21 shows the graph of above tabulated values with time (s) and length of actuator (m).

12) Finally, for bucket cylinder repeat steps 1-5.
13) Start the motion for this cylinder by inserting the time from 0 to 0.2 and value displacement from 2.29 to 2.39.

![Graph showing motion for bucket cylinder]

Figure 4.22 Value Motion for Bucket Cylinder

14) Figure 4.22 shows the graph of above tabulated values with time (s) and length of actuator (m).
4.6 MESH BODIES

To mesh the bucket attachments follow the following steps:

1) Right click on the bucket, it will open dialog box and click properties as shown in the Figure 4.23.

   ![Figure 4.23 Bucket Properties](image)

2) It will open properties and check the box “include the FEA and show the mesh “and click mesh as shown Figure 24.

   ![Figure 4.24 Bucket Properties Window](image)

3) Click close after that.

4) Now, repeat the steps 1 to 3 for each elements in the excavator.
4.7 LIST OF PARTS INCLUDED IN FEA AND THEIR PROPERTIES

Below is the list of parts and properties that have been included in Finite Element Analysis for the bucket attachment.

1) Bucket: Figure 4.25 shows bucket with generated mesh

![Bucket with Generated Mesh](image)

Figure 4.25 Bucket with Generated Mesh

<table>
<thead>
<tr>
<th>Default Mesh Size</th>
<th>0.0466 m</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mesh Factor</td>
<td>1</td>
</tr>
<tr>
<td>Nodes</td>
<td>43293</td>
</tr>
<tr>
<td>Elements</td>
<td>25123</td>
</tr>
</tbody>
</table>

Table 4.1 Properties of the Bucket
2) Boom: Figure 4.26 shows the boom with generated mesh.

![Boom with Generated Mesh](image)

**Figure 4.26 Boom with Generated Mesh**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default Mesh Size</strong></td>
<td>0.102 m</td>
</tr>
<tr>
<td><strong>Mesh Factor</strong></td>
<td>1</td>
</tr>
<tr>
<td><strong>Nodes</strong></td>
<td>20284</td>
</tr>
<tr>
<td><strong>Elements</strong></td>
<td>10375</td>
</tr>
</tbody>
</table>

**Table 4.2 Properties of the Boom**
3) Stick: Figure 4.27 shows stick with generated mesh.

Figure 4.27 Stick with Generated Mesh

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Mesh Size</td>
<td>0.0617 m</td>
</tr>
<tr>
<td>Mesh Factor</td>
<td>1</td>
</tr>
<tr>
<td>Nodes</td>
<td>21302</td>
</tr>
<tr>
<td>Elements</td>
<td>10929</td>
</tr>
</tbody>
</table>

Table 4.3 Properties of Stick
4) **Link 1**: Figure 4.28 shows Link 1 with generated mesh.

![Figure 4.28 Link 1 with Generated Mesh](image)

<table>
<thead>
<tr>
<th>Default Mesh Size</th>
<th>0.118 m</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mesh Factor</td>
<td>1</td>
</tr>
<tr>
<td>Nodes</td>
<td>667</td>
</tr>
<tr>
<td>Elements</td>
<td>328</td>
</tr>
</tbody>
</table>

**Table 4.4 Properties of Link 1**
5) **Link 2:** Figure 4.29 shows link 2 with generated mesh.

![Figure 4.29 Link 2 with Generated Mesh](image)

<table>
<thead>
<tr>
<th>Default Mesh Size</th>
<th>0.0881 m</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mesh Factor</td>
<td>1</td>
</tr>
<tr>
<td>Nodes</td>
<td>1781</td>
</tr>
<tr>
<td>Elements</td>
<td>897</td>
</tr>
</tbody>
</table>

Table 4.5 Properties of Link 2
6) Base: Figure 4.30 shows base with generated mesh.

![Base with Generated Mesh](image)

Figure 4.30 Base with Generated Mesh

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Mesh Size</td>
<td>0.0572 m</td>
</tr>
<tr>
<td>Mesh Factor</td>
<td>1</td>
</tr>
<tr>
<td>Nodes</td>
<td>28466</td>
</tr>
<tr>
<td>Elements</td>
<td>17720</td>
</tr>
</tbody>
</table>

Table 4.6 Properties of Base
7) Excavator Assembly: Figure 4.31 shows excavator assembly with generated mesh.

Figure 4.31 3 Dimensional Model with Generated Mesh.
Chapter 5

CASE STUDIES

The analysis of the bucket attachment for the excavator will begin with two kinds of materials ASIA 1020, which has been used to make the excavator and Hardox–400, the new material, which is used to improve the bucket attachment in this thesis. In addition, how can we use this kind of material to decrease the weight for stick and boom and make them harder? At the same time, we increase the bucket capacity from $0.65 \, m^3$ to $1.07 \, m^3$ and load condition from 25000 Pa to 30000 Pa on bucket without any failure. This thesis takes load condition 2, 3 as shown in chapter 2 and Figure 5.1 as main test to analysis all cases in this chapter because it is the most important load condition in the excavator.

Figure 5.1 Second and Third Load Condition: Lifting at the Maxima and Minima Distance from Axle of Rotation.

Finally, This process” FEA” needs computer that has a high properties and large capacity of hard driver, because this process takes around three hours to complete.
5.1 PREPARE PROCESS FOR RUN FEA

1) Double click on the bucket and select material tab as shown in the Figure 5.2.

![Figure 5.2 Material Properties for Bucket](image)

2) Select the Steel –ANSI C 1020 and click ok .as shown in the Figure 5.3.

![Figure 5.3 Material Properties for ANSI C 1020](image)
3) Repeat Steps 1 and 2 with all parts in this excavator for the case 1 and Hardox - 400 material for case 2.

4) After that, we need to apply the load on the bucket by selecting structural load on the tab mane as shown in the Figure 5.4.

![Structural Load Command](image)

Figure 5.4 Structural Load Command

5) Click inside bucket to apply the load as shown in the Figure 5.5.

![Apply Load in the Bucket](image)

Figure 5.5 Apply Load in the Bucket
6) Double click on the green arrow inside bucket, it will open properties and apply 25000 Pa in the distributed load “X= 25000 Pa, Y= -25000 Pa” in the steel test and “X= 30000 Pa, Y= -30000 Pa” when Hardox-400 test click close as shown in the Figure 5.6.

Figure 5.6 Load Properties Window  A) For Steel  B) For Hardox - 400
7) Apply the restraint by select restraint on the main tab as shown in the Figure 5.7.

![Restrain Command](image1.png)

Figure 5.7 Restrainment Command

8) Go to the down of excavator body and click it, it will restraint the body as shown in the Figure 5.8.

![Restrain Location](image2.png)

Figure 5.8 Restrainment Location
9) Run the FEA Analysis by going to tab in the bottom of screen and select “motion with FEA” as shown in Figure 5.9.

Figure 5.9 Motion with FEA Command
5.2 CASE STUDY 1 STEEL ANSI C 1020

In this case, excavator dumps force 25000 N in bucket, the bucket attachment will take 0.8 sec to move from the deepest point “A” to the highest point “B” with load 25000 N. During this motion, we will check the stress, strain and displacement for each form of 80 frame which use the excavator to transfer from point A to B as shown in the Figure 5.10.

Figure 5.10 Point A and B for Excavator

This case will use the original weight for bucket attachment, maximum operation weight and same material according to excavator specification for Cat 325 D L Excavator as shown in the table 5.1.
<table>
<thead>
<tr>
<th>Max Operation weight</th>
<th>25000 Pa</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boom weight</td>
<td>2500 kg</td>
</tr>
<tr>
<td>Stick weight</td>
<td>900 kg</td>
</tr>
<tr>
<td>Bucket weight</td>
<td>800 kg</td>
</tr>
<tr>
<td>Base weight</td>
<td>3000 kg</td>
</tr>
</tbody>
</table>

**Table 5.1 Excavator Specification**

Figure 5.11 shows the initial condition of the study. At time 0 second, force is resting on the boom. Between 0 to 0.8 second, boom cylinder starts increasing its length during this time and value displacement for this cylinder increasing from 2.05m to 2.85m every 0.01 sec and that led off the tilting of the bucket upward from the ground. At the same time the stick cylinder starts increasing its length from 2.66m to 3.46m by increase 0.01m every .01 sec, which maximize the length for it. Also, bucket cylinder starts increasing its length from 2.29 m to 2.39 m by increase 0.01m every .02 sec between 0 to 0.2 sec., which maximizes the length for it.

![Figure 5.11 Point A the Initial Condition of the Study.](image-url)
Now we are ready to look at results of the stress, strain, and displacement according to the previous information

a) **STRESS:**

Figure 5.12 shows the results of the stress for the excavator with material steel ASNS C 1020. In this Figure, we found the maximum value of Von Mises Stress in the second .04, which equal 45.8MPa. Which is below the 448 MPa yield stress for steel ASNI C 1020. Figure 5.13, 14, 15 shown as the results of the stress at 0.04, 0.2 and 0.36 sec respectively.

![Stress Graph](image-url)
Figure 5.13 The Result of the Stress at 0.04 Sec.

Figure 5.14 The Result of the Stress at 0.2 Sec
Figure 5.15 The Result of the Stress at 0.36 Sec
b) **STRAIN:**

Figure 5.16 shows the result of the strain for the excavator with Material steel ANSI C 1020 from 0 to .8 sec. In this Figure, we found the maximum value of Von Mises Strain in the second .04, which equal .000197 m. Figure 5.17,18 and 19 show the results of the strain at 0.04, 0.2 and 0.36 sec respectively.

![Figure 5.16 The Result of the Strain](image_url)
Figure 5.17 The Result of the Strain at 0.04 Sec

Figure 5.18 The Result of the Strain at 0.2 Sec
Figure 5.19 The Result of the Strain at 0.36 Sec
c) **DISPLACEMENT:**

Figure 20 shows the results of the displacement for the excavator with material steel ANSI C 1020 from 0 to .8 sec. In this Figure, we found the maximum value of displacement in the second .04 which equal .00064 m, it is much less than that of the minimum thickness of the plate in the boom. Figure 5.21,22 and 23 show the results of the stress at 0.04, 0.2 and 0.36 sec respectively.

![DISPLACEMENT IN STEEL AT 25000 N](image)

Figure 5.20 The Result of the Displacement
Figure 5.21 The Result of the Displacement at 0.04 Sec

Figure 5.22 The Result of the Displacement at 0.2 Sec
Figure 5.23 The Result of the Displacement at 0.36 Sec
5.3 CASE STUDY 2 HARDOX – 400

The Hardox - 400 will be the new material for case study 2 with elastic modulus, yield stress and ultimate tensile stress higher than the Steel ASAI C-1020 in case study 1 and mass density less than Steel ANSI C 1020 as shown in the Figure 5.24.

![Hardox-400 Properties](image)

**Figure 5.24 Hardox - 400 Properties**

According to the new specification in the Figure 5.24 above the weight of bucket, attachment will be decrease as shown in the Table 5.2.
<table>
<thead>
<tr>
<th></th>
<th>ANSI C 1020</th>
<th>HARDOX-400</th>
<th>Different</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Operation</td>
<td>25000Pa</td>
<td>30000Pa</td>
<td>+5000</td>
</tr>
<tr>
<td>Boom weight</td>
<td>2500 kg</td>
<td>1260 kg</td>
<td>-1240</td>
</tr>
<tr>
<td>Stick weight</td>
<td>900 kg</td>
<td>609 kg</td>
<td>-281</td>
</tr>
<tr>
<td>Bucket weight</td>
<td>800 kg</td>
<td>1000 kg</td>
<td>+200</td>
</tr>
<tr>
<td>Base weight</td>
<td>3000 kg</td>
<td>2790 kg</td>
<td>-210</td>
</tr>
<tr>
<td>Bucket Capacity</td>
<td>.65 $m^3$</td>
<td>1.07 $m^3$</td>
<td>+.20 $m^3$</td>
</tr>
</tbody>
</table>

Table 5.2 New Weights for Bucket Attachment According to Hardox - 400

Shown in the table 5.1 the weight bucket increases from 800 to 1000 because the new design of bucket as shown in the Figure 5.25 and Figure 5.26 has more width and more material. According to new design, we increase the bucket capacity from .65 $m^3$ to 1.07 $m^3$ and the load from 25000 Pa to 30000 Pa.

Figure 5.25 New Design for Bucket
After applying all information above, we will be ready to run FEA
a) **STRESS:**

Figure 5.27 shows the result of the stress for the excavator with new Material Hardox - 400 and the new design for bucket. In this Figure, we found the maximum value of Von Mises Stress in the second 0 and 0.2, which equal 36.7 MPa and 16.4 MPa respectively, and both are below than 1 GPA yield stress for the Hardox -400’s and also below the steel yield stress in case 1 as shown in the Figure 5.28. Figure 5.29, 30 and 31 shown as the results of the stress at 0, 0.2 and 0.34 sec respectively.

![Stress in Hardox-400 at 30000 N](image)

Figure 5.27 The Result of the Stress in Hardox - 400.
Figure 5.28 The Result of the Stress for Hardox – 400 and Steel ANSI C 1020
Figure 5.29 The Result of the Stress at 0 Sec.

Figure 5.30 The Result of the Stress at 0.2 Sec.
Figure 5.31 The Result of the Stress at 0.34 Sec.
b) **STRAIN:**

Figure 5.32 shows the results of the strain for the excavator with new material Hardox - 400 and new design. In this figure, we found the maximum value of Von Mises Strain in the second 0 and 0.2, which equal .000158 m/m and .000705 m/m respectively and below the result in the steel as shown in the Figure 5.33. Figure 5.33, 34 and 35 show the results of the strain at 0, 0.2 and 0.34 sec respectively.

![STRAIN IN HARDOX-400 AT 30000 N](image)

Figure 5.32 The Result of the Strain in Hardox - 400.
Figure 5.33 The Result of the Strain for Hardox – 400 and Steel ANSI C 1020

Displacement
Figure 5.34 The Result of the Strain at 0 Sec

Figure 5.35 The Result of the Strain at 0.2 Sec
Figure 5.36 The Result of the Strain at 0.34 Sec
c) **DISPLACEMENT:**

Figure 5.37 shows the results of the displacement for the excavator with new material Hardox - 400 in the new design. In this Figure, we found the maximum value of displacement in the second 0 and 0.2, which equal .00004 m and .00015 m respectively, which is very less than that of the minimum thickness of the plate in the bucket and more below than the steel displacement as shown in the Figure 5.38. Figure 5.39,40 and 41 show the results of the displacement at 0, 0.2 and 0.34 sec respectively.

![Graph showing displacement over time](image)

**Figure 5.37 The Result of the Displacement in Hardox – 400.**
Figure 5.38 The Result of the Displacement for Hardox – 400 and Steel ANSI C 1020
Figure 5.39 The Result of the Displacement at 0 Sec.

Figure 5.40 The Result of the Displacement at 0.2 Sec.
Figure 5.41 The Result of the Displacement at 0.34 Sec.
5.4 RESULTS

This thesis illustrates that we can design an excavator by using HARDOX - 400 instead of Steel ANSI C -1020. In fact, using HARDOX - 400 instead of Steel ANSI C 1020 gives us the opportunity to increases the bucket capacity from \(0.65 m^3\) to \(1.07 m^3\) with maximum operation load 30000 Pa instead of 250000 Pa in steel ANSI C 1020. Furthermore, the optimizations of the previous stick and boom causes that we have a new stick and boom for the excavator, which is nearly 30%-50% lighter than the original one.

According to previous information, we will be able to minimize the cost, construction cost and operating cost. At the same time, we maximize performance, efficiency and cycle time. However, we should consider that the manufacturing of the HARDOX - 400 increase our products cost by approximately $4000 - $6000, which should be acceptable if we factor with more efficient Excavator.
REFERENCES

[1] O'Donnell Consulting Engineers:


[3] SIMWISE 4D:

[4] COMPUTER AIDED DESIGN OF EXCAVATOR ARM: FEM APPROACH:


[7] Cat 325 D: